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Introduction 

About Cinema RAW Development 

Cinema RAW Development allows you to develop, play back and export Canon RAW files (referred to 
as “RAW clips” in this manual) shot with Canon digital cinema cameras. This software is also 
compatible with RAW clips recorded using a color space with a wider gamut than BT.709 (Cinema 
Gamut, BT.2020 or DCI-P3+). The following are the main features of Cinema RAW Development.

NOTES

When you use this software, make sure to set your computer so that it does not enter sleep mode.

Conventions in the Manual 

Important precautions related to the software’s operation.
Additional information that complements the main procedure.

0 Reference page number in this instruction manual.
File > Open This font is used to indicate menu options and commands, as they appear onscreen. 

• For the most part, screens shown in this manual were captured on a computer running Mac OS X, 
ver. 10.9. Actual screens may differ slightly.

Disclaimers
• This software was developed for exclusive use with RAW clips created using a Canon digital cinema 

camera and external recorder compatible with Canon RAW data.
• While every effort has been made to ensure that the information contained in this manual is accurate 

and complete, Canon shall not be liable for any damages resulting from corrupted or lost data due to 
mistaken operation or malfunction of the software. 

• Your camera may not support all of the features and functions described in this manual. Screens 
show clips recorded using a Canon EOS C500 digital cinema camera and external recorder.

• The software records internal operations, including full path information of the clips used, on a log file 
kept on the hard disk. The information recorded will be used only for the purpose of providing 
technical support in case of a problem with the software.

Develop and play back Develop RAW clips stored on your computer and simultaneously 
play the clips back.

Develop and export Develop RAW clips stored on your computer and export the clips 
as DPX files, OpenEXR files or MOV files. You can also copy RAW 
clips as is.

0
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Running Cinema RAW Development

Starting Up Cinema RAW Development 

Click on the Cinema RAW Development icon on the dock. After a short while, the application’s main 
window will appear.

NOTES

• Multiple instances of Cinema RAW Development cannot be opened simultaneously.
• If your computer is running resident software that periodically accesses the hard disk, such as an 

antivirus application, computer performance when playing back and exporting clips may decrease.

Exiting Cinema RAW Development 

Using the menu: Click Cinema RAW Development > Quit Cinema RAW Development.
From the main window: Click the  (Close) icon on the top left corner of the window.

Click

0
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Overview of the Main Window 

The main window shows the folders panel and clips panel.

Folders Panel 

Shows a list of folders on your computer. Select the folder that contains the desired clips.

Clips Panel 

After you select a folder in the folders panel, the clips panel will display the clips saved in that folder. 
From this panel, you can select which RAW clips* to play back or export. The list shows the file types 
(RAW, DPX and OpenEXR).
* RAW clips are folders that contain video, audio and management files.

Selecting Clips

Selecting clips in the Main Window
To play back or export a clip, you must first select it. When exporting, you can select multiple RAW 
clips.

In the clips panel, click on the desired clips.
• To select multiple, non-successive clips: Click the desired clips while holding the 2 key (2 + Click).
• To select multiple, successive clips: Click the first clip and then click the last clip while holding the 

Shift (7) key (Shift + Click).

Folders panel

Clips panel

File view format buttons

Add to Media Pool button

Add to Export Queue button

0



Overview of the Main Window

6

Changing the file view format
You can click the file view format button in the main window to switch how the clips in the clips panel 
are displayed.

Options
 Thumbnails Displays the each clip’s thumbnail, name, recording date/time and file type*.
 Detailed Information Displays the file type*, clip’s name, recording date/time, starting time code, 

ending time code, length, frame rate, shooting frame rate, number of 
frames, resolution, bit depth, audio type, number of audio channels and 
audio sampling rate. 
* The file type will be RAW, DPX or OpenEXR.

Icons displayed in the thumbnail
In thumbnail view, an icon of the file type is displayed to the upper left of the thumbnail.

Adding RAW Clips to the Media Pool

You can select the RAW clips you plan to use and add them to the media pool. In the media pool, you 
can display RAW clips saved in multiple folders. You can play back, export, view clip information and 
view frame information for such clips in a similar way to RAW clips in the clips panel.

1. Click View > Media Pool/EDL.
• The Media Pool/EDL window will appear.
• When the EDL screen is displayed, click Media Pool to display the media pool screen.

2. In the main window, select the RAW clips you wish to add to the media pool from the clips panel 
(�).
• You can select multiple clips at once.

3. In the main window, click Add to Media Pool (�).
• The selected RAW clips will be added to the media pool screen of the Media Pool/EDL window.
• You can also drag a clip from the clips panel and drop it on the media pool to add it.
• In the media pool screen, select the clip you want to use in the same way that you select a clip in 

the clips panel of the main window (0 5).

Thumbnail view Detailed information view

0
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NOTES

In the media pool, the file view format can be changed in the same way that you change the file view 
format in the clips panel of the main window (0 6).

Adding clips with the contextual menu
• In the main window, move the mouse pointer over a folder and then open the contextual menu. 

Select Add to Media Pool > Clips in Selected Folder or Clips in Selected Folder and Subfolders. 
The RAW clips in the selected folder or the selected folder and all subfolders will be added to the 
media pool.

• In the main window, move the mouse pointer over a RAW clip and then open the contextual menu. 
Select Add to Media Pool. The RAW clip will be added to the media pool.

�

�

0
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Removing clips from the media pool
Follow the steps below to remove a RAW clip from the media pool. 

1. In the media pool, select the desired RAW clip.
• You can select multiple clips at once.

2. Move the mouse pointer over the selected RAW clip and then open the contextual menu. 

3. Select Remove from Media Pool.

4. Select Yes.

Searching for Clips in the Media Pool (EDL Search)

In the media pool, you can search for RAW clips that are included in the time codes of events in the 
EDL and display them in a list (hereafter referred to as an “EDL search”). After you find RAW clips, you 
can add them to the export queue from the EDL screen.

1. Add the desired RAW clips to the media pool (0 6).

2. In the Media Pool/EDL window, click EDL (�).
• The Media Pool/EDL window will switch to the EDL screen.

3. From the FPS list (�), select the frame rate that matches the frame rate of the time code in the 
EDL.
• Available frame rates are 23.98, 24.00, 25.00, 29.97 DF, 29.97 NDF, 50.00, 59.94 DF and 59.94 NDF.

4. For 59.94P and 50.00P clips, remove the check from the Advance Time Code Every 2 Frames  
box (�) to advance the clip’s time code one frame at a time*.
* Some NLE systems generate an EDL with a time code that requires this step.

5. Click Select EDL (�) and select the EDL file for the EDL search.
• RAW clips that are included in the time codes of events in the selected EDL are displayed in a list.
• The EDL screen will be refreshed after you select an EDL file, add/delete clips to/from the media 

pool, select a different option in the FPS list, or change the Advance Time Code Every 2 Frames 
setting.

�

� �
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Items displayed in the EDL search results

Adding margins to the time codes in the EDL (source in/source out)
When performing an EDL search, you can compare with the time code of the RAW clip’s in point and 
out point and then you can set margins (0 to 5 seconds in 1-second increments, or 0 to 999 frames in 
1-frame increments) before/after the source in/source out. If you set the margins to n seconds, the 
RAW clip will be compared with a time code of –n seconds/frames for source in and +n seconds/
frames for source out, where n represents the margin length.

Item Description

No. Number indicating the event order in the EDL (event number).

Status  (green): Operation successful. A clip matching the frame rate in the FPS list was 
found.

 (red): Error. No matching clips found.
 (yellow): Warning. Multiple matching clips were found (conflict) or a clip not matching 

the frame rate in the FPS list (frame rate mismatch) was found. Move the 
mouse pointer over the icon to display which warning it is.

 (green with check mark): Conflict resolved. You selected one clip from the multiple 
clips that were found.

Clip Name RAW clip name.

Thumbnail Shows the first frame of the clip.

Source In Time code of the clip’s in point.

Source Out Time code of the clip’s out point.

Record In Time code of the starting point of the time line position in which the clip was placed after 
editing.

Record Out Time code of the ending point of the time line position in which the clip was placed after 
editing.

Margin (n seconds/frames)

RAW clip

EDL

In point

Source in Source out

Out point

0
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1. Click Cinema RAW Development > Preferences.
• The Preferences dialog box will appear.

2. Select the desired margin.
• To select the margin in seconds, select a value from the sec. list (�). To select the margin in 

frames, click the button next to the frames (�) value and enter a value between 0 and 999.

3. Click OK (�).

Searching for RAW clips that match error results
You can search for RAW clips in a desired folder that fall within the time codes of events resulting in an 
error from the EDL search. 

1. In the EDL display, select an event whose status is  (error).

2. Move the mouse pointer over the selected event and then open the contextual menu.

3. Click Search for Clips.
• A dialog box will appear.

4. Select the folder to search.
• RAW clips from the selected folder and all subfolders that fall within the time codes of the event 

from step 1 will be searched for.
• The results will appear in the EDL display. If only one RAW clip is found, it will be added to the 

media pool.

�

�

�
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Selecting a RAW clip to resolve during a clip conflict
When multiple RAW clips are found in the EDL search that result in a clip conflict, you can select the 
RAW clip to use for the event.

1. In the EDL display, select an event whose status is  (conflict).

2. Move the mouse pointer over the selected event and then open the contextual menu.

3. Click Resolve Conflict.
• A dialog box will appear.

4. Select the desired clip (�) and then click OK (�).
• The clip conflict will be resolved and the status will change to .

�

�
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Playing Back and Developing Clips

Displaying the Preview Window

The preview window shows the preview panel and development settings panel. You can develop and 
play back the RAW clip currently selected in the clips panel or media pool screen.

Click View > Preview.
• The Preview window will appear.

Playing Back Clips

This software features basic playback functionality of your clips. You can play back the RAW clip 
currently selected in the clips panel or media pool screen and display it in the preview panel. During 
playback, you can use the playback controls under the video display area. RAW clips will be played 
back using quick development (0 16).

1. In the clips panel or media pool screen, select the clip you want to play back (0 5).
• The video display area in the Preview window will show the first frame from the clip.
• After selecting a RAW clip, it is developed according to the settings in the development settings 

panel (0 16) and then displayed.

2. In the Preview window, click A to start the playback.
• The clip will be played back. The playback position slider and time code display will advance as 

the clip is played back.
• During the clip’s playback, the A button will change to B.

3. Click B to stop the playback.
• Selecting a different clip will also stop the playback of the current clip. 

Preview panel Development settings panel
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IMPORTANT

Your computer’s performance can affect the playback quality. In certain cases, you may notice some of 
the following anomalies.
- Playback is not smooth and frames are dropped.
- The displayed time code does not match the actual frame being displayed.
- Parts of the screen freeze or take longer to be refreshed.

NOTES

• You can play back RAW clips shot with Canon digital cinema cameras.
• When the input focus* is on the playback position slider in the preview panel, you can press the 

space key or K key to start/stop the playback.
* “Input focus” refers to the window or item that can receive keyboard input from the user.

Changing the way video is displayed
By placing a check in the 100% box or removing it, you can change how video is displayed in the video 
display area.

Options

100% box not checked Displays the entire video so that the entire picture is visible.

100% box checked Displays the video at actual size. As such, only a portion of the video will 
be displayed. The  mark inside the display area graphic to the right of 
the playback position slider indicates the area of the picture currently 
visible. You can use the mouse to drag the picture in the video display 
area to change what is being displayed.

Video display area

Time code Total duration of the 
clip
Playback position 
slider

Playback controls
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Adjusting the volume
Drag the volume slider to adjust the playback volume. You can click  to temporarily mute the sound 
( ). 

Changing the playback position
You can change the playback position during playback or in playback pause mode in the following 
ways.

Part of the picture currently visible

Display area graphic

Click to mute the audio

Volume slider

Playback position slider

Move to the out point

Next frame

Previous frame

Move to the in point
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* Usable when the input focus is on the playback position slider in the preview panel.

Repeating playback of a clip
When you place a check in the Repeat box, you can have the clip play back in a loop. After playing 
back to the out point, playback starts again from the in point.

Playing back 4K1K RAW clips
When 4K1K RAW clips are exported, the sides of the picture will be cropped depending on the output 
picture angle (resolution of the full-quality file). By adjusting the Resolution of Full-quality File setting, 
you can preview the cropped picture as it will be exported.

1. In the Export Configuration dialog box, select the resolution for Resolution of Full-quality File 
(A 23).

2. Place a check in the Export Markers box and play back the clip.
• The clip will be played back with a portion of the picture masked so that the visible area matches 

the resolution selected in step 1.

Mouse operation
Keyboard 
shortcut*

Action

home Move to the in point. Move to the first frame if the current 
frame position is before the in point.

end Move to the out point. Move to the last frame if the current 
frame position is after the out point.

Ô ← arrow or J Go back one frame.

Ó → arrow or L Advance one frame.

Playback position slider — Drag it to bring the playback position to the desired frame. 
You can also click on the slider to jump to the selected 
playback position.

Place a check in the box to repeatedly play back the clip

Export marker
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NOTES

• If you select a DPX or OpenEXR clip in the clips panel that was exported with this software, you can 
display a desired frame. Use the playback position slider, and the Ô (go back one frame) and Ó 
(advance one frame) controls to select a frame.

• The colors of OpenEXR clips will be different from those of the original RAW clips before export.
• This software displays OpenEXR clips by applying the Reference Rendering Transform (RRT), which 

is stipulated in the ACES specifications, and Output Device Transform (ODT) into BT.709.

Developing Clips

Adjusting the development settings
RAW clips must be developed before they can be played back or exported. You can adjust various 
development settings using the development settings panel.

1. Select the desired RAW clip from the clips panel or media pool/EDL window.
• The clip will be developed and the video display area will show the first frame from the clip.

2. In the development settings panel, adjust the desired settings.
• The clip is developed again based on the new settings and then displayed in the video display 

area.

3. Play back the clip (0 12). 

Return white balance to default 
settings

White balance adjustment mode

Color temperature

Brightness

White balance shift

Sharpness

Preview Settings: Gamma

Quick development

Click White Balance

Preview Settings: Color space
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Development settings
Default settings are underlined.

Setting Setting options Function

White 
balance 
adjustment 
mode

Shooting Settings, 
Click White Balance, 
Color Temperature

Selects how the white balance is adjusted. You 
can click K to return the setting to its default 
value.

Click White 
Balance

— Adjusts the white point. After clicking the  
button, click in the video display area to adjust 
the white balance by using the color of the 
location clicked as the white point.

Color 
Temperature

2,000 to 15,000 K 
(5200)

Allows you to adjust the color temperature using 
the slider or by directly entering a value (in 
increments of 100 K). 

Brightness -3.00 to 3.00 
(0.00)

Allows you to adjust the brightness using the 
slider or by directly entering a value (in increments 
of 0.01). You can click K to return the setting to 
its default value.

White Balance Shift -10.0 to 10.0 (0.0) Allows you to adjust the white balance shift using 
the slider or by directly entering a value (in 
increments of 0.1). You can click K to return the 
setting to its default value.

Sharpness 0 to 10 (0) Allows you to adjust the sharpness using the 
slider or by directly entering a value (in increments 
of 1). You can click K to return the setting to its 
default value.

Preview Settings: Gamma BT.709, 
Canon Log/Canon 
Log 2, 
Wide DR

Selects the gamma setting for development that 
will be applied during playback of a RAW clip. 
This setting will be applied to the preview panel 
and the picture output through the SDI terminal 
(0 19).

Preview Settings: Color Space Shooting Settings, 
BT.709, 
DCI-P3

Selects the color space setting for development 
that will be applied during playback of a RAW 
clip. This setting will be applied to the preview 
panel and the picture output through the SDI 
terminal (0 19). The Shooting Settings option 
refers to the settings at the time of shooting.

Quick Development Off, On When a check mark is placed in the box, 
processing is simplified when exporting RAW 
clips or during playback/playback pause, in order 
to shorten the development time. Because some 
processes such as false color reduction will not 
be implemented, the color and resolution will 
differ from the result obtained using normal 
development.
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Available Settings by Color Space Used While Recording
The color space and gamma settings available for displaying a clip in the software depend on the color 
space used when recording the RAW clips.

NOTES

• Use a computer with a GPU supported by this software to develop clips. Although it is possible to 
develop clips using a computer that does not have a GPU supported by this software, it is not 
recommend to do so. For the latest information on this software, including system requirements, visit 
your local Canon Web site.

• Development settings cannot be changed while playing back a RAW clip.
• You cannot adjust the sharpness of RAW clips that were recorded in HRAW recording mode 

(4096x1080, 3840x1080)
• When a clip with a color space of BT.709 or BT.2020 is selected, the Preview Settings: Color Space 

option in the development settings cannot be selected.

Setting In and Out Points

You can set the in and out points (starting and ending points) of a range of frames in a clip. By default, 
the first frame of the clip will be the in point and the last frame will be the out point. However, you can 
change these points. The in and out points will be represented by the ú and û icons, respectively. 

* Usable when the input focus is on the playback position slider in the preview panel.

Color space used for recording
Display settings

Color space Gamma

Cinema Gamut,
DCI-P3+

Shooting Settings

Canon Log / Canon Log 2,
BT.709,

Wide DR,
DCI

DCI-P3 Canon Log / Canon Log 2,
DCI

BT.709
Canon Log / Canon Log 2,

BT.709,
Wide DR

BT.2020 –
Canon Log / Canon Log 2,

BT.2020,
Wide DR

BT.709 –
Canon Log / Canon Log 2,

BT.709,
Wide DR

Mouse operation
Keyboard
shortcut*

Action

ú I Sets the current frame as the in point. 

û O Sets the current frame as the out point.
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1. Select the frame you wish to set as in or out point.

2. Click ú or û to set the in or out point, respectively.
• The corresponding mark will appear above the selected position on the playback slider.

NOTES

• You can set in and out points to export only a specific portion of a clip (0 21).
• When a RAW clip is selected in the EDL screen, the in and out points will be displayed in the Source 

In and Source Out fields of the EDL. If an EDL Confirm Margin is set, the time code displayed will 
already reflect the applied margin.

Connecting to an External Monitor Using SDI Output

If your computer has an expansion card with SDI output capability, you can use this software to play 
back clips on an external monitor using your computer’s SDI terminal*. During output, an output area 
graphic (see the illustration below for an example) will be available to select what portion of the 
playback picture is displayed but the playback picture itself will not appear in the graphic. 
Refer also to the instruction manual of the expansion card.
* The picture resulting from playing back a clip with this software will be referred to hereafter as the “playback picture”.

1. Connect the external monitor to the computer’s SDI terminal.
• Follow the procedure in the instruction manual of the expansion card.

2. Click Cinema RAW Development > Preferences.
• The Preferences dialog box will appear.

3. Select the video output configuration that matches the external monitor’s capability (�).

4. Click OK (�).

5. Click the SDI OUT button (�).
• A graphic will appear in the video display area indicating what portion of the picture is being 

displayed. 
• Click the SDI OUT button again to disable SDI output.

6. Play back the clip (0 12). 
• The playback picture will be output from the SDI terminal.
• The size of the output picture will automatically be enlarged or reduced depending on the aspect 

ratio of the playback picture and the resolution selected in step 3 for External SDI Monitor. If the 
aspect ratios are different, the output picture will be letterboxed or pillarboxed.

In point icon

Out point icon

Set In Point button

Set Out Point button
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To play back without reducing the size
Place a check in the 100% box.
• During playback pause, you can use the mouse to drag the picture on the output area graphic to 

change what is being displayed.

NOTES

• If you select 4096x2160 RGB, 3840x2160 RGB or 2048x1080 RGB for External SDI Monitor, clips 
with a frame rate of 59.94P or 29.97P will be output at 23.98P and those with a frame rate of 50.00P 
will be output at 25.00P. If you select 1920x1080 RGB, clips with a frame rate of 59.94P will be output 
at 29.97P and those with a frame rate of 50.00P will be output at 25.00P.

• If the playback picture size is reduced, moiré patterns or other artifacts may appear.
• If the resolution of the clip and SDI monitor differ, dropped frames may occur during playback.

�

�

�

Preferences dialog box

SDI OUT button

Output area graphic
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Exporting Clips

Adjusting the Export Settings

You can select the type of file exported, the file name and the destination folder. You can also set the 
desired color space and gamma settings individually for each color space option used for recording. 
Perform the settings before adding the desired RAW clip to the export queue. You can also change the 
settings of clips already in the export queue.

1. Click View > Export.
• The export window will appear.

2. Click the  button (�).
• The export configuration dialog box will appear.

3. Click the Output Settings tab (�).
• The output settings screen will appear.

4. Select how the exported file’s name will be generated (�).

Use clip name of metadata
For clips other than MOV clips:

[metadata clip name]1_[number corresponding with the RAW file].[file extension]
For MOV clips:

[metadata clip name].MOV

Use same file name as RAW file
For clips other than MOV clips:

[RAW file name].[file extension]
For MOV clips:

[RAW file name].MOV

Enter file name
For clips other than MOV clips:

[file name input by user2][_consecutive clip number3]_[number corresponding with the RAW 
file].[file extension]

For MOV clips:
[file name input by user1][_consecutive clip number2].MOV

1 This is the clip name that was given to the clip recorded on a recording media in the camera/camcorder at the same time 
the RAW clip was recorded. If no clip was recorded on a recording media when the RAW clip was recorded, then the file 
name method will be the same as that of Enter file name.

2 Every time you add clips to the export queue, you will be asked to enter the desired file name.
3 This consecutive number is added when multiple clips are added to the export queue at once.

• For proxy files, “Proxy_” will be added to the beginning of the file name.

5. Under Export Destination, click Browse and then select the export destination folder (	).

6. Under Export File, select the development process (
).
Output Full-quality Files The RAW clip that is output is developed normally so that the gener-

ated file will have image quality as close as possible to the original 
RAW clip.

Output Proxy Files The RAW clip that is output is partially developed and reduced in size 
so that the generated file will be easier to edit.

Copy RAW Files The RAW file is copied to the export destination folder.

7. Next, you can select detailed color space and gamma settings for the exported files.
• Depending on your selection for the Export File setting in the previous step, change the desired 

settings under the Output Type (Full-quality Clips) tab (A 22), the Output Type (Proxy Clips) 
tab (A 23) or both. 
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Settings for Full-quality Clips

1. Click the Output Type (Full-quality Clips) tab (�).
• The output file type screen will appear.

2. Select the file type (�), color space (�) and gamma setting (	).
• Refer to the Available Settings by Color Space Used While Recording table (A 18).
• You can select the following for the file type.

DPX RGB 10-bit
DPX RGB 16-bit
Apple ProRes 4444
OpenEXR (ACES)

• You can select the desired color space settings for each of the color space options that could be 
used for recording. You can select the following for the color space setting. However, you cannot 
select the color space setting if the file type is OpenEXR (ACES).
Shooting Settings
BT.709
DCI-P3

• You can select the desired gamma settings for each of the color space options that could be used 
for recording. You can select the following for the gamma setting. However, you cannot select the 
gamma setting if the file type is OpenEXR (ACES).
Canon Log / Canon Log 2
BT.709
BT.2020
Wide DR
DCI

• When the file type of the exported full-quality file is OpenEXR (ACES), note the following.
- The file will be output as ACES color space without the color space setting applied.
- The file will be output as scene-linear data without the gamma setting applied.
- For ACES IDT (
), you can select Auto Select, Daylight or Tungsten.

�

�




�

	
Export window

Export Configuration dialog box (output settings)
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3. If you selected to export 4K1K RAW clips, select the full-quality file resolution (�).
• You can select from the following options.

4096x1080
4096x2160 (Letterbox)
2048x1080 (Side Crop)
1920x1080 (Side Crop)
2538x1080 (Side Crop)

4. Click OK (�).
• If necessary, continue with the following procedure to change the settings under the Output Type 

(Proxy Clips) tab instead of clicking OK.

Settings for Proxy Clips

1. Click the Output Type (Proxy Clips) (�) tab.
• The output file type screen will appear.

2. Select the file type (�), color space (�) and gamma setting (�).
• Refer to the Available Settings by Color Space Used While Recording table (A 18).
• You can select the following for the file type.

DPX RGB 10-bit 720x480
DPX RGB 10-bit 1920x1080
Apple ProRes 4444 720x480
Apple ProRes 4444 1920x1080
Apple ProRes 422 (HQ) 720x480
Apple ProRes 422 (HQ) 1920x1080
Apple ProRes 422 720x480
Apple ProRes 422 1920x1080
Apple ProRes 422 (LT) 720x480
Apple ProRes 422 (LT) 1920x1080
Apple ProRes (Proxy) 720x480
Apple ProRes (Proxy) 1920x1080

• You can select the following for the color space setting.
Shooting Settings
BT.709
DCI-P3

�

�

�

�

�

�

�

Export Configuration dialog box Output Type (Full-quality Clips) tab
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• You can select the following for the gamma setting.
Canon Log / Canon Log 2
BT.709 
BT.2020
Wide DR
DCI

• You can also place a check in the Same as Full-Quality Files box (�), to use the same color 
space and gamma settings selected with the previous procedure.

3. Click OK (�).

Processing and file types

Development process Output file Picture output Gamma

Output Full-quality 
Files

DPX RGB 10 bit 
RGB 16 bit

Canon Log / 
Canon Log 2,
BT.2020,
BT.709,
Wide DR,
DCI

MOV Apple ProRes 4444

OpenEXR RGB 16 bit Linear

Output Proxy Files DPX RGB 10 bit 720x480
RGB 10 bit 1920x1080

Canon Log / 
Canon Log 2,
BT.2020,
BT.709,
Wide DR,
DCI

MOV Apple ProRes 4444 720x480
Apple ProRes 4444 1920x1080
Apple ProRes 422 (HQ) 720x480
Apple ProRes 422 (HQ) 1920x1080
Apple ProRes 422 720x480
Apple ProRes 422 1920x1080
Apple ProRes 422 (LT) 720x480
Apple ProRes 422 (LT) 1920x1080
Apple ProRes (Proxy) 720x480
Apple ProRes (Proxy) 1920x1080

�

�

�
�

�

�

Export Configuration dialog box Output Type (Proxy Clips) tab
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NOTES

• Files will be saved in subfolders in the folder you selected in step 5. For full-quality files, the subfolder 
name will have the same name as the RAW clip. For proxy files, the subfolder name will have the 
same name as the RAW clip with “Proxy_” added to the beginning. For RAW copied files, the 
subfolder name will have the same name as the RAW clip with “Copy_” added to the beginning.

• When an OpenEXR clip is exported, it will be converted into a color space defined by the Academy 
Color Encoding System (ACES), which was proposed by the Academy of Motion Picture Arts and 
Sciences (AMPAS).

• Changing the export settings with clips already in the export queue
- You can change the export settings after clips were already added to the export queue. When the 

confirmation message appears, select Yes to apply the new export settings also to the clips that are 
already in the export queue.

- If a dialog box appears prompting you to change the file name, enter a file name and click OK. The 
new file name will be applied also to the clips that are already in the export queue.

Developing and Exporting RAW Clips

You can develop a RAW clip and convert it to a standard file type for export. You can also save a log file 
of the export operations performed.

1. In the clips panel or media pool screen, select the RAW clip to be exported.

2. Adjust the development settings as necessary (0 16).

3. In the main window, click Add to Export Queue (�).
• If a dialog box appears prompting you to change the file name, enter a file name and click OK.
• The selected RAW clip(s) will be added to the bottom of the export queue.
• You can also drag a clip from the clips panel or media pool screen and drop it on the export queue 

to add it.
• You can also move the mouse pointer over the selected folder/RAW clip and perform the 

operation from the contextual menu (0 33).
• In the media pool screen, click Add to Export Queue to add a RAW clip in the media pool to the 

queue.

4. Repeat steps 1 to 3 as necessary to add other RAW clips to the export queue.
• You can change the export settings for each clip separately (0 21).

5. If necessary, activate the option to save a log file of the export operations (A 28).

6. Click Export (�).
• The RAW clips in the export queue will be exported in order starting from the file on the top. 
• The range of frames from the in point to the out point will be exported.
• RAW clips that have been exported will be removed from the export queue and then be added to 

the export result list.
• For clips that are displayed in the export result list, you can select Show All, Show Clips with 

Errors/Canceled Exports or Show Successful Clips.
• After the export operation begins, Export will change to Cancel, which you can click to cancel the 

export process. If part of the files have already been exported when you cancel the operation, you 
will be asked whether you want to delete the output files already exported. Click Delete to delete 
all the output files already exported.

• You can click Delete All (�) to clear the export result list.
• You can develop full-quality files using quick development. Proxy files will always use quick 

development regardless of the Quick Development setting (A 17).
• When all the RAW clips in the export queue have been exported, a notification message will 

appear. Click OK to close the message.
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Items displayed in the export queue and export result list

Item Description

Clip Name Shows the name of the RAW clips. 

Frame Shows the frame currently being processed on the left and the total 
number of frames on the right. The number on the left will be 
updated while RAW clips are being exported. This appears only in 
the export queue.

Folder for Exported Files Shows the folder to which exported files are saved.

Full-quality File Shows whether the RAW clip is being exported as a full-quality file 
(Export) or not (Do Not Export), and if so, the output file type, color 
space, gamma setting and ACES IDT (for OpenEXR files only).

Proxy File Shows whether the RAW clip is being exported as a proxy file 
(Export) or not (Do Not Export), and if so, the output file type, color 
space and the gamma setting.

Copy Shows whether a copy of the RAW clip is being exported.

Export status area During the export operation, in the export status area you can check 
the number of clips remaining in the queue, the progress status 
(percentage) and the elapsed time since the export operation started.

Export Result The  (blue) icon indicates that the file was successfully exported, 
the  (red) icon indicates an error, and the  (yellow) icon indicates 
a canceled operation. 

Status Shows details of the export results (explains the reason an error 
occurred).

�

�

�

Export queue

Export result list

Export status area
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Messages displayed in the status column

NOTES

The following operations cannot be performed during export.
- Playing back a clip
- Adjusting development settings
- Viewing clip information or frame information

Removing clips from the export queue
Follow the steps below to remove a RAW clip from the export queue.

1. Select the RAW clip to remove from the export queue.
• You can select multiple clips at once.

2. Click  (�).
• The selected RAW clip will be removed from the export queue.

Changing the destination folder
You can change the destination folder for clips added to the export queue.

1. Select a RAW clip in the export queue.
• You can select multiple clips at once.

2. Click Change Folder (�) and select the destination folder.

Item Description

Successful Clip export was completed successfully. 

Development Error The RAW clip is corrupted. Use backup data.

Destination drive does not exist. Cannot access the drive that contains the destination folder. Check 
the drive.

Insufficient Space The drive that contains the destination folder does not have enough 
available space. Select a different drive for the destination folder.

Read Error The RAW clip is corrupted. Use backup data.

Write Error Could not write to the destination folder. Check that the folder 
permissions allow for writing.Cannot Create a Folder

Unknown Error An error not covered by the other error messages in this list, such as 
a lack of memory error, has occurred. After restarting your computer, 
perform the operation again.

Canceled The export operation was canceled.
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Adding a RAW clip in the export result list to the export queue again
You may find it convenient to add a RAW clip in the export result list to the export queue again in cases 
such as when an error has occurred.

1. Select a RAW clip in the export result list.
• You can select multiple clips at once.

2. Click Add Again to Queue (�).
• The selected RAW clips will be added to the export queue with their previous settings.
• If necessary, you can also change the destination folder.

Saving the export log

1. Click Cinema RAW Development > Preferences.
• The Preferences dialog box will appear.

2. Place a check in the Save Export History box (�).

3. Click Browse (�) and select a destination folder. 

4. Click OK (�).
• The export log from this point on will be saved in an export log file (CSV format).
• Export log files are generated on a daily basis on days in which files are exported. The file’s name 

will appear in the destination folder as [CRD_Export_YYYYMMDD].CSV where YYYYMMDD 
represents the year, month and day.

��

�

�
�

�
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Data recorded in the export log file

Item Description

Status Shows the result of the export process. 

Date Shows the date in which the file was exported.

Time Shows the time in which the file was exported.

Source Shows the file path of the RAW clip.

Destination Shows the file path of the exported file.

Type Shows the output format of the exported file. If the RAW file was 
copied, this appears as RMF.

Resolution Shows the resolution of the exported file.

Color Space at the Time of Shooting Shows the color space of the RAW clip.

Color Space after Conversion Shows the color space of the exported file.

Gamma Shows the gamma settings for the exported file. For OpenEXR 
files, this appears as Linear.

IDT Shows the IDT setting applied to OpenEXR files.

Start TC Shows the starting time code for the exported file.

End TC Shows the ending time code for the exported file.
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Displaying and Editing Metadata

Displaying Clip Information

When you display the clip information window, you can display the clip information in the metadata 
associated with the RAW clip that is selected in the clips panel or media pool screen.

Click View > Clip Information.
• The clip information window will appear. 

Entering and editing clip information

1. In the clip information window, double-click Clip Title, Creator or Description.
• The Edit Clip Information dialog box will appear.

2. Enter text or edit the fields as necessary.
• You can enter up to 1000 characters into the description field and a maximum of 100 characters 

for the other fields.

3. Click OK.
• The user information will be saved with the RAW clip.
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Displaying Frame Information

When you display the frame information window, you can display the frame information (information on 
each frame in the RAW clip) recorded in the metadata of the frame that currently appears in the preview 
window. During playback, the information will be updated to match the frame being played back.

Click View > Frame Information.
• The Frame Information window will appear.
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Reference and General Information

Menus and Keyboard Shortcuts

Main menu bar

Menu
submenu

Keyboard
shortcut

Function 0

Cinema RAW Development

About Cinema 
RAW 
Development

— Displays details about the software’s version. Also 
displays the GPU name when a compatible GPU 
is detected and the number of GPUs, if more than 
one is detected.

—

Preferences 2 + , Opens the Preferences dialog box. 19

Services — Standard option for Mac OS. —

Hide Cinema 
RAW 
Development

2 + H Standard option for Mac OS.
—

Hide Others 1 + 2 + H Standard option for Mac OS. —

Show All — Standard option for Mac OS. —

Quit Cinema RAW 
Development

2 + Q Exits Cinema RAW Development. 4

File

Export 
Configuration

— Opens a dialog box where you can adjust export 
settings.

21

Start Export — Starts export.
25

Cancel Export — Stops export.

Select EDL — Selects the EDL so that you can search the media 
pool for RAW clips that match the editing data in 
the EDL.

8

Edit

Cut † + X Standard option for Mac OS. —

Copy † + C Standard option for Mac OS. —

Paste † + V Standard option for Mac OS. —

Delete › Standard option for Mac OS. —

Select All † + A Standard option for Mac OS. —

Start Dictation — Standard option for Mac OS (OS X 10.8 Mountain 
Lion and later).

—

Special 
Characters

1 + 2 + T Standard option for Mac OS.
—

View

Preview — Opens or closes the preview window. 12

Media Pool/EDL — Opens or closes the media pool/EDL window. 6

Export — Opens or closes the export window. 21

Clip Information — Opens or closes the clip information window. 30

Frame 
Information

— Opens or closes the frame information window. 31
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Contextual menus
Following is a list of menus that appear when you control (^) –click* certain icons. The contextual menu 
displayed will depend on the location of the mouse pointer at the time of clicking.
* You can right-click instead, if you are using a multi-button mouse.

Contextual menu in the folders panel

Contextual menu in the clips panel

Display at 100% † + control + N Displays the picture in the preview panel at 100% 
size. Select this option again to display the picture 
at the previous size.

13

Display Export 
Makers

† + control + M Displays the export marker when previewing a 
4K1K RAW clip.

15

Windows

Minimize 2 + M Standard option for Mac OS. —

Zoom — Standard option for Mac OS. —

Bring All to Front — Standard option for Mac OS. —

Cinema RAW 
Development

— Brings Cinema RAW Development to the front. —

Help

View Instruction 
Manual

— Open’s Cinema RAW Development’s instruction 
manual (this PDF file). —

Menu Options Function 0

Add to Media Pool Clips in Selected 
Folder

Adds all RAW clips in the selected folder to the 
media pool.

7

Clips in Selected 
Folder and 
Subfolders

Adds all RAW clips in the selected folder and all 
subfolders to the media pool.

Add to Export Queue Clips in Selected 
Folder

Adds all RAW clips in the selected folder to the 
export queue.

25

Clips in Selected 
Folder and 
Subfolders

Adds all RAW clips in the selected folder and all 
subfolders to the export queue.

Menu Function 0

Add to Media Pool Out of the selected clips, adds the RAW clips to 
the media pool.

7

Add to Export Queue Out of the selected clips, adds the RAW clips to 
the export queue.

25

Menu
submenu

Keyboard
shortcut

Function 0
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Contextual menu in the media pool screen

Contextual menu in the EDL screen

Menu Function 0

Add to Export Queue Adds the currently selected clip to the export 
queue.

25

Remove from Media Pool Removes the currently selected clip from the 
media pool.

8

Menu Function 0

Search for Clips Searches for clips that match events with a status 
of  (error).

10

Resolve Conflict Selects a clip when multiple clips are found that 
matches an event with a status of  (conflict).

11
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Troubleshooting Error Messages

Following is a partial list of error messages in alphabetical order.

A clip conflict has occurred. Resolve to continue.
• The EDL search resulted in multiple clips being found. Select the clip to use (0 11).

Cannot add clips. Export queue has reached the maximum number of clips.
• The export queue already contains the maximum number of RAW clips. You can add other RAW clips after 

export has finished.

Cannot add clips. Media pool has reached the maximum number of clips.
• The media pool already contains the maximum number of clips (999 clips) so additional clips cannot be 

added.

Cannot add clips because a corresponding IDT does not exist.
• Because the selected RAW clip was recorded using a color space that is not supported by the software, it 

cannot be exported with a file type of OpenEXR. Select a DPX or MOV file type when exporting.

Cannot start program due to insufficient memory.
• Close other applications and then start this software again.

Cinema RAW Development has already been started by other user.
• Multiple users cannot open the software simultaneously on the same computer. The user who has already 

started the software must exit it.

Could not add some clips. Export queue has reached the maximum number of clips.
• The export queue has reached the maximum number of clips (999 clips) so additional clips cannot be 

added.

Could not add some clips. Media pool has reached the maximum number of clips.
• The media pool has reached the maximum number of clips (999 clips) so additional clips cannot be added.

EDL Conform Margin is set to 0 seconds.
EDL Conform Margin is set to 0 frames.
• You tried to add a clip found from the EDL search to the export queue while the EDL Conform Margin 

setting was set to 0 seconds or 0 frames. To prevent this message from appearing, remove the check from 
the Display a warning when a clip is added to the export queue with EDL Conform Margin set to 0 sec./0 
frames box in the Preferences dialog box.

EDL not found. Select the EDL again.
• The EDL file was moved from its previous location. Select the EDL file again.

The media pool could not be restored to its previous state (how it was the last time the application was 
closed).
• One or more clip files were moved from their previous location. Add the desired RAW clips to the media 

pool again.

There are clips whose settings could not be changed.
• A list of clips in the export queue whose export settings could not be changed will be displayed. Click Yes 

to change the export settings only of those clips whose settings can be changed.

There are events with an error. The following clips will not be added.
• Check the event number with an error. Look for clips that match the results (0 10) and add them again to 

the export queue. 

There are events with mismatching frame rates. The following clips may not be added correctly.
• In the media pool/EDL window, set the frame rate in the FPS list correctly (0 8).
• If your intention is to add the clip, click Add.
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Trademark Acknowledgements
• Mac OS is a trademark of Apple Inc., registered in the U.S. and other countries.
• Other names and products not mentioned above may be trademarks or registered trademarks of 

their respective companies. 

For support concerning this software, please contact a Canon Service Center. For details see the 
back cover of your camera’s Instruction Manual.

The information in this manual is verified as of July 2015. Subject to change without previous notice.

PUB. DIE-0428-000D © CANON INC. 2015


	Introduction
	About Cinema RAW Development
	Conventions in the Manual

	Running Cinema RAW Development
	Starting Up Cinema RAW Development
	Exiting Cinema RAW Development

	Overview of the Main Window
	Folders Panel
	Clips Panel
	Selecting Clips
	Selecting clips in the Main Window
	Changing the file view format
	Icons displayed in the thumbnail

	Adding RAW Clips to the Media Pool
	Removing clips from the media pool

	Searching for Clips in the Media Pool (EDL Search)
	Adding margins to the time codes in the EDL (source in/source out)
	Searching for RAW clips that match error results
	Selecting a RAW clip to resolve during a clip conflict


	Playing Back and Developing Clips
	Displaying the Preview Window
	Playing Back Clips
	Changing the way video is displayed
	Adjusting the volume
	Changing the playback position
	Repeating playback of a clip
	Playing back 4K1K RAW clips

	Developing Clips
	Adjusting the development settings

	Setting In and Out Points
	Connecting to an External Monitor Using SDI Output

	Exporting Clips
	Adjusting the Export Settings
	Settings for Full-quality Clips
	Settings for Proxy Clips

	Developing and Exporting RAW Clips
	Removing clips from the export queue
	Changing the destination folder
	Adding a RAW clip in the export result list to the export queue again
	Saving the export log


	Displaying and Editing Metadata
	Displaying Clip Information
	Entering and editing clip information

	Displaying Frame Information

	Reference and General Information
	Menus and Keyboard Shortcuts
	Main menu bar
	Contextual menus

	Troubleshooting Error Messages



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.3
  /CompressObjects /Off
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /CMYK
  /DoThumbnails true
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments true
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Preserve
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile (None)
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /Description <<
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000410064006f006200650020005000440046002065876863900275284e8e9ad88d2891cf76845370524d53705237300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef69069752865bc9ad854c18cea76845370524d5370523786557406300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA <>
    /JPN <FEFF9ad854c18cea306a30d730ea30d730ec30b951fa529b7528002000410064006f0062006500200050004400460020658766f8306e4f5c6210306b4f7f75283057307e305930023053306e8a2d5b9a30674f5c62103055308c305f0020005000440046002030d530a130a430eb306f3001004100630072006f0062006100740020304a30883073002000410064006f00620065002000520065006100640065007200200035002e003000204ee5964d3067958b304f30533068304c3067304d307e305930023053306e8a2d5b9a306b306f30d530a930f330c8306e57cb30818fbc307f304c5fc59808306730593002>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020ace0d488c9c80020c2dcd5d80020c778c1c4c5d00020ac00c7a50020c801d569d55c002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken die zijn geoptimaliseerd voor prepress-afdrukken van hoge kwaliteit. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings to create Adobe PDF documents best suited for high-quality prepress printing.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /ConvertToCMYK
      /DestinationProfileName ()
      /DestinationProfileSelector /DocumentCMYK
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure false
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles false
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /DocumentCMYK
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /UseDocumentProfile
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


